Microscopy-Assisted Digital Photography as an Economical Analytical Tool for Assessment of Food Particles and Their Distribution Through The use of the ImageJ Program

Andrey A. Tyuftin 1, Halimah Mohammed 1, 2, Joe P. Kerry 1*, Maurice G. O’Sullivan 2**, Ruth Hamill 3, Kieran Kilcawley 4

1Food Packaging Group, School of Food & Nutritional Sciences, University College Cork, College Road, Cork, Ireland
2Sensory group, School of Food & Nutritional Sciences, University College Cork, College Road, Cork, Ireland
3Ashtown Food Research Centre, Teagasc, Ashtown, Dublin 15, Ireland
4Food Quality & Sensory Science Department, Teagasc Food Research Centre, Moorepark, Fermoy, Ireland

Received Date: March 29, 2021; Accepted Date: April 07, 2021; Published Date: May 7, 2021

*Corresponding author: Joe P. Kerry, Food Packaging Group, School of Food & Nutritional Sciences, University College Cork, College Road, Cork, Ireland; Tel: +3530214903798; Email: joe.kerry@ucc.ie

**Corresponding author: Maurice G. O’Sullivan, Sensory group, School of Food & Nutritional Sciences, University College Cork, College Road, Cork, Ireland; Tel: +353214902058; Email: maurice.osullivan@ucc.ie

Food particles analysis in ImageJ program

Abstract figure
Abstract

Numerous technologies are available for particle analysis, such as laser diffraction, laser in-line particle size analysis, acoustic attenuation spectroscopy etc. However, in many situations, particle size analysis needs only to be conducted in single-type research, negating the purchase of high cost equipment. Microscopy assisted photography can be used followed by the analysis of the photo in ImageJ program in this case. It has been known seaweeds possess a high nutritional profile and can partially replace some ingredients such as salt. In represented method we describe an analytical tool for food particle size diameter analysis and probability distribution validated using four different seaweed separates (2360 to 355 µm mesh sizes). This method is cheap and consists of an ordinary digital camera (or cell phone camera), any microscope (or cell phone lens) or digital micrometer (for large particles) and open-sourced software – ImageJ. For seaweed sample separates obtained from 212 to 180 µm sieve mesh sizes, only microscopy equipped with a digital camera was employed. This method can be applied for any other industry such as biological samples, pharmaceutical etc., with particular any range of particles distribution depending on accuracy required and camera lens resolution.

Keywords: Feret Diameter; Food Particles; Food Particle Microscopy; ImageJ program; Particle Analysis; Particle Distribution by Photography; Seaweed; Separation; Wakame

Introduction

Numerous technologies are available for particle analysis, such as laser diffraction, laser in-line particle size analysis, acoustic attenuation spectroscopy etc [1, 2]. However, in many situations, particle size analysis needs only to be conducted in single-type research, negating the purchase of high cost equipment and microscopy assisted photography can be used followed by the analysis of the photo in ImageJ program. The ImageJ program was developed by Rasband [3] and is an open-sourced software which allows analyses of various parameters within a broad object range, from cells to nanoparticles [4], even for astronomical study of stellar objects. ImageJ takes part of its name the language of Java script. The Program is designed to work with different image formats, including “raw”. ImageJ users can work with it online or download it for use on different platforms.

ImageJ allows users to measure distances of objects, angles, calculate line profile plots, allows manipulation of images via contrasting, sharpening, smoothing and possesses several inserted image filters and plugins [3, 5]. ImageJ has wide application in all the sciences and can work as a supporting tool for other analytical techniques. In order to analyze particles in ImageJ, it is necessary to import an image file, then subject it for thresholding and particle analysis. In all cases it is necessary to set the value of an initial diameter, volume or other parameter used for scaling the ratio of pixels to real distances from the photo before particle analysis. For this approach, a known scale or measurement equipment is required in order to measure necessary parameters. For example, in the case of nanoparticle image analysis, a known scalederived from a scanning electron microscope requires setting.

From a food processing perspective, analysis of food ingredients in terms of particle size is extremely important and is becoming more so, in that least cost formulation of food products requires the maximum interaction between ingredients, without excessive use of ingredient quantities. This type of ingredient interaction is very influenced by the particle sizes of the ingredients employed. Seaweeds serve as novel sources of food ingredients and can be employed in the least cost formulation of food products. Consequently, there is a requirement to classify seaweed ingredient functionality based on ingredient particle size.

In many cases microscopy can be used for particle size analysis in ImageJ after their separation [9, 10], but it takes a long time to analyse a sufficient quantity of particles for statistical purposes [11]. For microscopic sugar particle analysis for example, it has been shown that at least 100 particles per separated fraction were required to satisfy meaningful measurement [5]. However, this problem can be overcome by utilizing and applying a simple photographic approach which can capture hundreds of times more particles simultaneously than measurements conducted on a microscope followed by Image analysis. In a case such as this, microscopy can be used separately as a concomitant method for scaling diameter analysis. In one research paper [7], seaweed particles were analyzed for the first time in water with the application of the ImageJ program using high-resolution photography, however, the use of microscopy had not been investigated. Additionally, shape identification and sieve particle size distribution analysis using ImageJ was also reported for food grains and ground biomass [12-15].

We report the application of the ImageJ program using digital photography for rapid and economical food particle probability distribution analysis, where seaweed particle separates of Irish Wakame (IW - Alaria esculenta), Nori (NR - Porphyraumbilicalis), Sea spaghetti (SS - Himanthalia elongate) and Dulse (PP - Palmiariapalmata) (2360 to 180 µm mesh sizes) were chosen as a model of valuable food ingredients in particle form and where microscopy was used for setting up a pixel diameter scale on the photo, as derived from the real particle size diameter which was determined previously from microscopic measurements. The primary focus of our research was on particle diameter distribution within ground and sieved seaweed samples for application for various purposes within processed meat samples.
Materials and Methods

Four types of dried seaweeds, namely; Irish Wakame (IW - Alaria esculenta), Nori (NR - Porphyra umbilicalis), Sea spaghetti (SS - Himanthalia elongate) and Dulse (PP - Palmaria palmata) were supplied in flaked form in a wide diameter range by Wild Irish Seaweed, Co. Clare, Ireland. Each seaweed type was sieved (see details below) and following this process, all samples were held in sealed polyethylene bags and stored at room temperature in a dry place.

Microscopy Analysis

The ImageJ program, Wayne Rasband, National Institutes of Health, USA was downloaded from the relevant website [3] and used offline. A Nikon digital camera (Tokyo, Japan), installed on a vertically-movable stand, was used for all photographic purposes. An Olympus BX61 microscope (Tokyo, Japan) was employed in transparent mode for reference particle diameter measurements and was equipped with a camera and connected to a PC. CellSens™ standard software [16] was used for the max diameter measurement of the selected particles which was calibrated before with a special calibrator. Microscopy was used to measure the max diameter of the selected particle (reference object) in order to assign diameters scale of the other particles on the photo in ImageJ program after photographing.

Sieving

Seaweeds flakes were mechanically sieved through a sequence of sieves, namely: 2360, 1180, 710, 500, 355, 212, 180 µm mesh size set in a sieve-shaker (Endeotts Octagon 200, London, UK). Sieving was carried out in batches of 200g for each seaweed type for 10 min at 5 rpm.

Measurement of Particle Size

The distribution of whole seaweed particle portions by measurement of diameters from each sieved separate sample was determined by specifically measuring the Feret particle diameter for up to 1000 particles per fraction (which was dependent on the specific fraction analyzed and particle width) using the ImageJ program for each batch photo taken. Pixel diameters from each photograph were scaled to µm with the help of optical microscopy.

For photographic purposes, each sieved seaweed separate sample (from 2.36 mm to 355 µm mesh size), for each seaweed type studied, was placed on an A4 format paper sheet and evenly spread across the paper in order to leave free-space around each seaweed flake particle. The digital camera was fixed above the paper in a perpendicular plane to the center of the paper sheet. The smallest optically-captured particle for each seaweed fraction sample was marked before photography commenced in order to measure its perimeter max diameter on a microscope using the 50x magnification lens and the cellSens™ standard software [16]. This was used to measure particle diameters in µm for subsequent scaling of diameters as measured in pixels on images employing the ImageJ program (mean value was based on five measurements). A digital micrometer (Kafer Digital Thickness gauge, Kafer Messuhrenfabrik GmbH & Co., Villingen-Schwenningen, Germany) was used to measure seaweed particle diameters on photographs when they proved to be too large to measure through microscopic assessment (for sieve apertures 2.36, 1.18 mm). Mean value was based on five measurements. We recommend to use microscopy in all cases for all particles due to using the digital micrometer will drastically reduce accuracy of measured diameters. In our case we haven’t lens which would allow to measure large particles on the microscope.

It has to be noted that Feret’s diameter orientation can slightly affect the results as each particle can be oriented differently in space and therefore will have different projections, but in our study it was neglected since most of the particles were flat-surfaced. In order to achieve better accuracy of the results, particles’ orientation on the paper sheet can be changed several times by spreading them and taking photos again after each orientation change.

Images obtained from photography were subjected to ImageJ software analysis in order to obtain a Feret diameter map for each seaweed separate and this was achieved through the use of the following protocol:

- On each image of seaweed particles, color and brightness were adjusted for increased sharpness and to exclude unnecessary patterns (marks, etc.) until image became clear and white background appeared. In a situation where two or more particles shielded each other and the diameter for each particle could not be analyzed by the program, these conglomerates were cut from the image by selecting them and deleting (Figure 1).
- A line tool was used for a previously marked particle. In this instance, the perimeter diameter was measured in the same way as it had been previously measured for the same particle using a microscope. Then, the “Set Scale” function in the “Analyze” menu was used to adjust scale from pixels to µm, “Global” was ticked.
- Then, when all diameters could be measured in µm from a given image, image was converted to 8-bit which was selected from the menu and subjected to “Thresholding” by clicking appropriative button.
- Subsequently, in the “Analyze” menu, “Analyze particles” was retrieved with the following parameters: Size (0-Infinity), Circularity (0.00-1.00). “Display results” and “Add to manager” were ticked. After proceeding, all particles became numbered and the results from the File menu in tabular form were saved in order to open them in Microsoft Excel.
Microscopy-Assisted Digital Photography as an Economical Analytical Tool for Assessment of Food Particles and Their Distribution Through The use of the ImageJ Program

Figure 1: Digital photo of the 710 µm-mesh size separate of IW seaweed particles. The unnecessary deleted area is shown in rectangles (a). Particle 1 (circled) was taken to measure diameter on a microscope for scale correction from pixels to µm in ImageJ (a); numbered mapping of the particles in ImageJ program (b); photo of the circled particle with measured diameter on a microscope (c); probability normal particle diameter (µm) distribution of IW 710µm-mesh size separate based on the data from ImageJ mapping (a, b), processed in Excel (d).

Results and Discussion

Each particle could be found by its number and the relative Feret diameter associated with each particle was shown in the Excel files generated, and this could be achieved for up to 1000 particles in some cases, depending on the seaweed particle quantity photographed for each sample (Supplementary data*** and Figures 1, 2). Thus, each particle was numbered, identified through mapping and its area and Feret diameter determined. It has to be noted that ellipses can be generated from a single image and from which minimal and maximal particle diameters can be determined (Figure 2).

We recommend using a high-resolution camera for the analysis of particles with low dispersity. It should be noted that the distance between particles and camera lens must be the same for all photos with a good camera focus and the camera must be installed in a perpendicular direction to the surface where particles are spread. There should be a distance between particles, otherwise they will overlap each other.
Figure 2: Digital photo of the 1180 µm-mesh size separate of IW seaweed particles. Particle 1 (circled) was taken to measure diameter on a digital micrometer for scale correction from pixels to µm in ImageJ program (a); ellipses created in ImageJ indicating each particle (b); numbered mapping of the particles in ImageJ program (c); Probability Normal Particle Diameter Distribution of IW 1180 separate based on the data from ImageJ mapping processed in Excel (d).

Seaweeds Particles Analysis

Owing to the fact that seaweed particles were not ideally spherical, it meant that particles appeared to be unevenly spherical at times and could appear as flat, stick-like or cylindrical objects (Figure 3), consequently seaweed particles could be described as having a high variety of sphericity.
There are various parameters that can be applied for estimating different particle size diameters such as Sieve diameter, Martin diameter, Volume equivalent diameter, Area equivalent diameter, Feret’s diameter and others [16]. The Feret’s diameter indicates the longest distance between two parallel lines on opposite sides of the projected particle or the particle’s maximum dimension [17] (Figure 4). It was chosen as the easiest parameter to measure in imaging due to it is included in ImageJ program in standard outputs already.

Feret diameter data for each fraction was copied and pasted into a separate Excel file in order to conduct distribution analysis. In order to achieve this, Feret diameter data were sorted from largest to smallest and for those particles whose diameter was too much at variance from the marked particle size before microscopic measurement, these data points were omitted. Subsequently, the mean and standard deviation values for particle diameters were calculated for each separate sample using =AVERAGE and =STDEV functions in “Excel”. After creating a probability normal distribution graph in “Excel” (using NORMDIST – x, mean, standard deviation, FALSE), the particle sizedistribution for each seaweed sample could be established (seetable files attached in Supplementary data *** ) in line with adoption and application of the following equation, again using the “Excel” program:

\[
y = \frac{1}{\sigma \sqrt{2\pi}} e^{-\frac{(x-\mu)^2}{2\sigma^2}}
\]

\[
\mu = \text{Mean} \\
\sigma = \text{Standard Deviation} \\
\pi \approx 3.14159 ... \\
e \approx 2.71828 ...
\]

In order to obtain the information pertaining to seaweed particle size distribution for each sample fraction prior to sieving, diameter size data for each fraction was placed in one “Excel” column, sorting in “Excel” from “Largest to Smallest” was applied, mean, standard deviation and probability normal distribution calculated. For example, (Figure 5) shows probability normal distribution curves for each separate sample and a total Normal distribution for the entire fraction (-) for IW seaweed particles.

**Figure 3.** Different seaweed particle forms (digital photography, fraction 2.36 mm mesh size is shown for all seaweed particles).

**Figure 4: Maximal Feret’s diameter of a particle projected on the surface.**

For sample separates obtained from 212 and 180µm-mesh sizes, only microscopy was utilised to measure diameters for all particles, instead of employing photography, owing to particles being so small that they were outside of the camera zoom limit. For these samples, each seaweed batch or sample portion was spread on a glass slide for microscopy, for maximum separation of sample particles and the perimeter diameters of 20 particles was measured manually by cellSens™ software in accordance with the referenced method for doing so [18]. Subsequently, another sample or portion was taken after mixing of the separate.
Figure 5: Probability normal distribution of IW separate seaweed particles and total particle distribution calculation based on more than 3500 particles (ln (diameter)).

Method Validation and Test Reliability

This method was repeated on another three seaweeds employing similar mesh sieve sizes used for separation of SS, NR and PP seaweed particles (Figures 6 - 8) with different size distribution.

Figure 6: Probability normal distribution of SS seaweed separate particles and total particle distribution calculation based on 1900 particles.
Figure 7: Probability normal distribution of NR separate seaweed particles and total particle distribution calculation based on more than 3000 particles.

Figure 8: Probability normal distribution of PP separate seaweed particles and total particle distribution calculation based on more than 2000 particles.

As it can be seen from the graphs ImageJ program with digital photography tools allows to carry out quickly analysis of particle distribution and each fraction probability distribution can be distinguished properly. Other microscope types
equipped with some form of precision measuring tool could be used with the current method and a simple phone with a camera possessing a high resolution could also be used for particle photography instead of employing a digital camera, but in case of very low resolution it will introduce an inherent irreproducibility.

**Conclusion**

In this paper, we have presented a simple, cheap method for food particle analysis in a model study employing flaked seaweed ingredients which circumvents the necessity to purchase complex and expensive equipment for the same purposes. The current method can employ any camera for particle photography; even that contained on a fairly basic model of a smartphone. By employing the ImageJ program, which is free, flexible and very functional software, analysis of food particle size can be achieved in a precise and efficient manner, thereby circumventing traditional microscopic particles analysis while increasing particle range for statistical purposes. Microscopy can be employed as an additional analytical tool to photography for particle scale diameter adjustment in combination with the ImageJ program. Experimental set-up is very simple and merely requires photographic equipment installation above the ingredient samples under investigation, with an allowance for camera movement in a perpendicular manner to move closer to, or further away from particles, based on size.

The proposed approach is user-friendly for general operation by students, researchers and industrial personnel alike and very suitable for use where single particle analysis and its probability of size distribution is required on an occasional basis for food and non-food ingredient samples with a particular any range of particles distribution depending on accuracy required and camera lens resolution.

“***Supplementary Materials: The following are available online at www.mdpi.com/xxx/s1, all files including photos of seaweed fractions Excel files generated from the ImageJ program for all images including numbering of particles and relative particles Feret diameters, Probability diameters distributions for all fractions are given as additional files (folder names IW seaweed all files, SS seaweed all files and NR seaweed all files). Supplementary material related to this article can be found, in the online version.

(OR)

Please click on the Links below for Data,
- Normal distribution IW separates
- Normal distribution NR separates
- Normal distribution PP separates
- Normal distribution SS separates

**Author Contributions**


**Funding**

“This research was funded by the Food Institutional Research Measure (FIRM), grant number R17360, administered by the Department of Agriculture, Food and the Marine.”

**Conflict of Interest**

Authors declare no conflict of interest.

**References**

18. CellSens™ software, Olympus, https://www.olympus-lifescience.com/en/software/cellsens/?gclid=EAIaIQobChMIqsK2yM2b5QIVzUPTCh1-RggyEAAYASAAEgIIgvD_BwE